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Sasheena Kurfman, Math teacher at Buckeye Union High School, presented this to interested teachers to help 
integrate technology into their curriculum and work. 

 
Internet Hot-Spots 

1. The internet has many great resources for gathering information to use with worksheets and handouts. 
One such location is www.clipart.com. This website has a zillion copyright free images that they 
provide (for a fee). Because they are copyright free, I do not feel any qualms about using their search 
feature to find a graphic I want for a worksheet or handout. After searching and finding the perfect 
image, I use the “print screen” button, usually just above the “insert” button near the “delete” button, 
and then I use Microsoft Paint to select the part of the image I want to use on my document. The 
preview images from clipart are usually about the right size for a worksheet and are generally the only 
images I use for worksheets. Larger images have a “watermark” running through the image.  

2. www.wikipedia.org is an interesting site that you might have heard of. The BIG FLAW is that anyone 
can edit any page to make it say what they want it to say, so any single article on the site can only be 
taken with a “grain of salt.” It is still, however, a great resource, because usually the information is true 
or nearly true. They also cite further resources on any good page, and from those resources other 
information can be gleaned from sites that can’t be altered like Wikipedia. I consider Wikipedia to be a 
great “jumping off point” when trying to find out information on any given topic. When used wisely, it will 
help you to find the correct information very fast. I’ve only contributed to it once however: Thanksgiving 
dinner before it was cooked. You can see it if you look up “Capon”.  

3. http://www.eduplace.com/graphicorganizer/ a graphic organizer web page 
4. http://www.artcyclopedia.com/ a place to look up art.  
5. http://www.teachers.net/cgi-bin/lessons/sort.cgi?searchterm=Senior high school lesson plans 
6. http://glossary.plasmalink.com/glossary.html#T Glossary of instructional strategies  
7. http://www.mathematicallycorrect.com/allen4.htm An interesting article on Language and the Learning 

of Mathematics 
8. http://maps.google.com/ Maps of the world… you can get up close and personal. Last time I looked up 

BUHS on the map, I could see my car in the parking lot and know that the satellite picture was taken 
while school was in session.  

9. http://www.ade.state.az.us/ Arizona Department of Education 
10. http://www.andoverhs.anoka.k12.mn.us/imc/bogus.html A list of bogus web sites that your students 

might try to use on their research papers. These web sites are all about people, places, and products  
that don’t truly exist. This is also entertaining reading.  

11. http://www.asset.asu.edu/ This is a great website with lots of cool information, even classes that can 
be taken to get professional development hours for re-certification.  

12. http://www.disciplinehelp.com/teacher/ A website with some discipline suggestions to help with 
classroom management.  

13. www.myschoolbuilding.com To fix stuff in your classroom, and request maintenance, go to this 
website. The organization account number is: 24410487 and the password is password 

 
Microsoft Paint 

This simple program might seem to have very little functionality when compared with some of the more fancy 
paint programs out there. But what is great about it is that it is free, it is on your computer and you can use it 
to do a lot of cool things.  
14. If you found an image from clipart.com or wikipedia.org or any other website, you use the “print screen” 

button to copy the image on the screen, and then you open up Paint, and go to the edit button and 
down to “paste”. You will have an image of your entire desktop and can then select the part you want 

to copy into your document with the “square lasso” tool. . When you’ve found what you want to 
copy, you select it with the lasso, use the Edit menu and select “copy”. Then in your word program you 
select “paste” to insert the picture into your document.  
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15. When using Microsoft Paint it is good if you know of a few of the tricks. One is the “opaque 

background”  and “translucent background”  buttons. If you select an object and want to 
move it elsewhere on the drawing window, you might prefer a translucent background, so you can see 
exactly where you are placing the object you’ve selected.  

16. You can select an item and flip or rotate it using the “image” menu and going down to Flip/Rotate.  

17. You can zoom in closer on the object you are working on using the zoom tool:  

18. you can select a color you like from anything on your computer screen using the eyedropper tool:  
 

 
IGPro 

This is a great tool for recording and sharing information about your students with your students and their 
parents. There are many nuances to the program that can make it more functional and useful.  
19. Name your spreadsheets: When you make a printout and the printout says Weighted Type <Numeric 

Weighted Type> at the top, it seems kind of redundant and lacking in real information. To change it so 
that it says the name of the class, go to the “Setup” menu, then down to “Spreadsheets…” and here 
you will see that there is a place to change the name from “Weighted Type” to whatever the name of 
the course is… you can have yours say Basket Weaving 101 <numeric weighted type> if you want.  

20. Custom Special Scores #1: Students should receive a grade of unexcused for tests, quizzes, and 
homework for which they have an unexcused absence. Instead of just putting a zero, it can be more 
useful to put UNX as their score. This has to be programmed into IGPro. To do this, you go to the 
“Setup” menu, and then down to “Grading Rules”. Go to the “Special Scores” tab, and then click the 
“new” button at the bottom left. Type UNX as the name of the new symbol, and put 0 for the score 
value.  

21. Custom Special Scores #2: When you get a new student towards the end of the semester and the 
transfer grade is something strange like 72.5%, one of the easiest ways to put that transfer grade into 
the computer is to create a special score. Following the steps in the previous tip, instead of UNX put in 
three letters that you might use for a student. For example, if the students name is Bob Jones, you 
might use BJ and put the score value of 72.5. Once you have created the new grade symbol, go to the 
spreadsheet and right click on the student’s name. Go to the option to “Fill row” and in the box you put 
the symbol you’ve chosen. In this example, I would put BJ and because I’m cautious I would select the 
box labeled “replace only empty scores”. This quickly adds the transfer grade with very little work on 
the part of the teacher.  

22. Custom Special Scores #3: Some of my assignments are designed to be “pass fail” and it gets 
repetitive to enter a score of 20 over and over and over again. Using the steps in the two previous tips, 
I create a new grading rule called “X” and make that one worth 100%. It makes entering grades easier.  

23. Number of Decimals When students are given a printout of their grade, they often wonder why the 
percent missing doesn’t actually add up properly. One way to avoid this problem is to have the number 
of decimals set to “1”. To do this, go to the “setup” menu, and then to “Grading Rules” then select the 
“Grade Tables” tab. In the upper middle, you can select the number of decimal points.  

24. Changing the Display 
colors If you don’t like 
the colors or the way that 
the gradebook displays 
data, you can change a 
number of options: To 
get the dialog box below, 
go to the “Setup” menu 
and then to the “Display” 
option. These are fun to 
play with, and if you 
really make a mess of 
things, you can start all 
over again by clicking the “use default colors” option.   
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25. Show Inactive Students In the “Display” dialog box, you can choose whether or not you want to show 
the inactive students. This is a great option, and also available on the bottom left of the screen where 
you enter the actual grades. Students who transfer out will become invisible but their information will 
remain in case they transfer back in, or in case there is a question about their transfer grade. 

26. Student Progress Reports When printing student progress reports or spreadsheets, one way to limit 
the amount of information that students have about other students is to de-select the “class average” 
and the “% of spreadsheet” options. This eliminates questions about the grades other students are 
getting, and helps students to focus on the grades they are getting.  

27. Students with IEP’s that require modification of the grade: When I receive the IEP thumbnails, I 
want to mark any and every student who needs modification of their grade. I go to the “Setup” menu, 
and down to the “Students” icon and select the appropriate student. After their first name I usually put 
something like “(MOD)” next to their name. This will not appear when a grade printout is produced with 
student ID numbers, but will help as a reminder when it is time to submit grades.  

28. TA’s: I use the same method as the tip above, to modify student’s name so that when I alphabetize the 
names, the TA’s name will drop to the bottom of the list. In front of their last name I put a Z so that it 
will not interfere with entering grades. Caution! If you have a student in one of your class hours as a 
student and another class hour as a TA, this will not work, when you change their name, you change it 
in both places.  

29. Students who need an NC, have modifications to their grade, and TA’s. For all of these students 
who have a need for a modification of the grade that the computer will produce, I usually enter an INC 
on one task, so that I will remember when posting grades that I need to research their grade more 
carefully. It is important to remember to check those grades thoroughly before they are exported.  

30. Report Setup If you use a special symbol for full credit, or otherwise have something that will always 
appear on your printouts you can use the Report Setup feature to include important interpretation 
information for those who read the report. In my gradebook, an L means the assignment is late and 
only 50% is received on the assignment. So I go “Reports” and then to “Report Setup” and my report 
title says “L means 50% for late assignments”. This makes it easier for students and parents to read 
the printout.  

 
ClassXP and SASIXP: 

31. Custom Buttons Class XP and SASI will allow you to look up important and pertinent information 
about your students. To the right you will see the buttons I have on my computer that I use frequently. 
To get these buttons, you have to open up the SASI Modules icon in the upper right side of the screen 
in SASI or in CLASSXP (it doesn’t matter which program you do this in, it will make the changes for 
both programs for you). In here you will find all of the buttons to the right.  

32. Student Info Button: This button will give you contact information about the student, as well as 
information on page 3 about their AIMS results. Click on the “SASI Modules” icon, and then on the 
“Student Info” briefcase. Inside you will see the “Student” icon. Drag that icon over to a blank menu 
button on the left of the screen.   

33. Classes Button: This button will give you class schedule information about the student. If you 
need to know where a student is for a specific period of the day, you can use this button to track 
them down. Click on the “SASI Modules” icon, and then on the “Student Info” briefcase. Inside you 
will see the “Classes” icon. Drag that icon over to a blank menu button on the left of the screen. 

34. Period Att. Button: This button will give you information about the student’s attendance in yours 
and other periods in the day. This is a great way to find out if students are ditching your class, and 
other vital information. Click on the “SASI Modules” icon, and then on the “Attendance” briefcase. 
Inside you will see the “Period Attendance” icon. Drag that icon over to a blank menu button on the 
left of the screen. 

35. Grades Button: This button will give you information about the student’s grades in your class as 
well as all other classes. Remember that this and all other information gained from the SASI and 
CLASSXP programs are confidential. Click on the “SASI Modules” icon, and then scroll down to the 
“Grade Reporting” briefcase. Inside you will see the “Grades” icon. Drag that icon over to a blank 
menu button on the left of the screen. 

 
Customizing Your Desktop 

Personally, I hate clutter. My desktop has six icons: My Document, a Junk folder, Internet Explorer, My 
Network Places, My Computer, and the Recycle Bin. My background image used to be a nuclear bomb (for 
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when I was in the Meet & Confer Committee, to represent my feelings!). Now it is one of the Kittens I’m trying 
to give away.  
36. To have a custom background, or change the one you currently have, go to the desktop and right-click 

somewhere there isn’t an icon. On the menu that pops up, select “properties”  and then the “Desktop” 
tab. In the window you will see a list of images you can select as your background. Choose one and 
then click “Apply” before closing the window. You now have a new desktop.  

37. If you want to create a custom background from a picture you found on the internet, first find a picture 
you like. There are some GREAT background images to be found here: 
http://en.wikipedia.org/wiki/Category:Wikipedia_featured_desktop_backgrounds on this site you can 
select a picture you like, click on it so that it is no longer a “thumbnail” and then again to get the largest 
and nicest image available, then to set it as your background image, right-click on the image with your 
mouse and select “Set as background”… when you next look at your desktop, you should see the 
desktop image. (If you only see a portion, right-click on the background, select “properties” and the 
“Desktop” tab, and then in the “Position” drop down menu, choose “stretch”.  

38. The “Properties” dialog box you used in the previous two tips is a fun 
one to play with. You can change the appearance of your desktop, the 
color of menu bars, and the screen saver. Have fun and play around 
with the different options.  

39. My computer has the traditional Window’s Classic look. One of the 
biggest ways that I save time with my computer is by modifying the 
icons in the taskbar. I go to the taskbar at the bottom of the screen and 
right-click and select “properties” Select the tab for the “start menu” 
and choose your preference. Our computers came standard with the 
Windows XP start menu, but if you prefer you can have the classic 
appearance from earlier eras. I’ve put all of my most-used programs 
into the taskbar so that I can select them without searching for them: I 
drag the icon for any program I use frequently on the small icon menu 
near the Start button, and then click the double left arrow to access the 
programs.  

 
 

BUHS Webpage 
If you want to improve your webpage now, so that you will have very little to do in the “build your webpage” 
in-service in the fall, check your webpage and make the changes now instead of later:  
40. Go to  www.buhsd.org to see how your web page looks.  
41. If you need to make changes, go to www.buhsd.org and click on the Our Staff link and go to the links 

and resources. The logon link is on that page, or you can go to the following link if you prefer: 
http://208.179.48.119/asp/security/login.asp 
and see if you can log in. (ask for 
instructions by calling x1251 or emailing 
skurfman@buhsd.org for logging in if you 
don’t remember or know how or if you don’t 
remember your user name or password) 
 

Things to check:  
42. Are there any strange characters that need to be eliminated? Do you see a “&nbsp” in the text for 

your webpage? If there are strange typos, log in and go to the page with the errors and delete all of the 
spaces between the words, up to and including the letters before and after the space where the &nbsp 
symbol appears on the web. Retype the letters and put a SINGLE space between the words. NEVER 
type a double space or you will get &nbsp on your webpage. For example, if your text says “Welcome 
to &nbsp my webpage” you will want to delete the following and then retype it with only ONE space: 
“Welcome to &nbsp my webpage” Don’t forget to Save 

43. Does the information about you look good? Are there typos? Fix them. Don’t forget to Save 
44. Does the webpage show your email address as first initial followed by last name? If it is first name 

followed by the initial of your last name, you will need to change it to first initial last name like so: 
skurfman@buhsd.org. The old email addresses with first name and last initial will be deleted from the 
system soon, so use the appropriate format. Don’t forget to Save 
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45. Does your web page show the phone number that goes directly to your classroom? If it doesn’t please 
make sure that it does. A lot of classrooms have the phone number of 327-2 followed by the last three 
digits of your extension. For example, my extension is 1251, so my phone number is 327-2251. 
Change the phone number on your web page. Don’t forget to Save 

46. Does your teaching schedule reflect the classes you teach each hour this school year? If it doesn’t, fix 
it. Don’t forget to Save 

47. Does your web page have a separate link for each distinct type of class you teach? If it doesn’t, it 
should have. For example, I teach Geometry, Honors Geometry, and AIMS Prep, so I have two links 
on my page. If you don’t have classes go to “ADD CLASS” at the bottom and add your class(es) Don’t 
forget to Save 

48. Does your web page have links for classes you don’t teach? Click on the class, and then scroll down to 
the bottom and hit “delete”. Only do this if you are sure that this is a class you do not teach. Don’t 
forget to Save 

 
On each of the sub-pages for the classes you teach, check to be sure that: 

 
49. You have your course rules. Specific rules for your classroom, taken from your classroom 

management plan. If you don’t, add those. Don’t forget to Save 
50. You should have YOUR grading scale on this page. For instance, if 10% of the grade in Basket 

Weaving 101 is based on the final project, it should reflect that. This is NOT the place to put the 
universal information that 94% and up is an A. If you don’t have your grading rules, add them. Don’t 
forget to Save 

51. You should have a homework policy listed that reflects YOUR policy, not the policy of the school. 
Explain whether students can turn homework in early or late, what the penalties are, how those 
assignments are treated. Are they worth full credit? Half credit? If you don’t have a policy on your 
webpage, make sure that you add one, and Don’t forget to Save 

52. You should have a makeup policy listed that reflects YOUR policy of what types of homework students 
can make up, how they can make it up, etc. If you don’t have one, then add one, and Don’t forget to 
Save 

53. At the top of the course description page you should have a quick synopsis of what the class is about. 
This can be taken from the course description guide. Make sure that there are no typos, no “&nbsp” 
typos. If this isn’t on your class page, add it. Take care of any of the &nbsp typos and Don’t forget to 
Save 

54. Make sure you SAVE after each change. If you don’t save, you have WASTED your time.  
55. Don’t add a photo to the website. If you do, you are opening yourself up to having web-theives steal 

your image. One year a teacher found out that some nice student had taken her photo, created a 
MySpace page for her, and listed numerous dubious practices on the page as if they were really her 
choice. This can be alarming and misleading to the public. Do NOT post your photo.  

56. Once you have updated your website and your updates are complete, your password will be changed. 
This is a security feature. If you need to change something on your website, just contact Mrs. Kurfman 
at x1251 or email her and she will give you temporary access.  

 
Microsoft Word 2007 

Progress is good, or so they say, so we have to get used to the new Word program that has been installed 
on our computers. I’ve kept the old tips and tricks for Word 2003, and am adding some new ones for Word 
2007. If you haven’t used Word much before, you will find this new version of word more intuitive and easy to 
use. If, on the other hand, you customized your version of Word last year after the technology workshop, you 
might find this new version clunky and moronic. If that is the case, I’ll show you how to re-customize your 
new version of Word to the best of its abilities to be customized. Also included here are a few of the great 
features that can be found in this version of word.  
57. Preview: One of the things that is absolutely excellent about this new version of Word is the ability to 

preview what certain changes would make to a document without actually making them. This probably 
makes little sense unless you actually see it happen. The basic idea is that if you are trying to decide 
what font is the best, or what font size, then you can go through the list of fonts and as the cursor goes 
over each font, the document will change to reflect the new font. You can see what that font will do to 
your document without actually selecting it. The same holds true for font sizes. This is an excellent way 
to improve productivity, and make your documents look better.  
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58. Customizing the Quick Access 
Toolbar: The quick access toolbar is the 
only way to make any custom menus in 
Word 2007, and there is only one menu 
allowed. You begin by right clicking on the 
toolbar in the upper left corner next to the 
Office button. You’ll see something like 
the menu at the rest to pop up: Select “Customize Quick Access Toolbar…” You’ll see a large dialog 
box with all of the possible menu commands available on the screen. The commands I have copied 
over to my menu include “open”, “new document”, “save”, “print…”, “send as attachment”, “bold”, 
“Italic”, “underline”, “center”, “left justify”, “undo”, “repeat action”, “insert symbol”, “insert equation”, 
“superscript”, “subscript”, “page border”, “small caps”, “strikethrough”, “save as…”, “insert table”, “table 
borders”, “color shading”, “align center”, “split cells”, “distribute rows evenly”, “distribute columns 
evenly”, “replace”, “page setup”, “insert/edit header”, “insert page break”, “font”, “font size”, and “zoom”. 
There is probably room for two or three more icons. You can also organize the icons in this dialog box, 
and choose to put the menu below the ribbon instead of on top, which brings it closer to your 
workspace, as well as allowing for a longer menu.  

59. Minimize the Ribbon: in the same menu that was called up when you right clicked on the quick 
access toolbar, is the option to minimize the ribbon. This will give you more space for what you are 
working on, and when you need a menu option, you can select any of the broad “ribbon categories” 
and bring up the corresponding ribbon.  

60. Adding things to the Quick Access Toolbar if you find a menu command that you would normally 
use frequently, you only need to right click on the menu option and a menu will pop up that will allow 
you to add it to the quick access toolbar. If you don’t like the location where the button is placed, use 
the “customize the quick access toolbar” menu item to rearrange the location of the different buttons.  

61. SAVE AS this is a very important and useful tool in Word 2007, especially if you have Word 2003 at 
home and will be working on documents in both locations. Make sure that any new document you 
create and save to be worked on at home is saved in the Word 2003 mode. Otherwise you will be 
unable to open the file with your Word 2003.  

62. Program symbols and frequently typed words: In Word 2003 you can program it to replace a 
combination of characters with something else. For example if you were writing an article on 
Beelzebub, and hated typing the name, you could program it to recognize that blz should be replaced 
with Beelzebub every time you type it. Math teachers use many symbols like ∆∞∑≈≥. It can be very 
practical to program in these symbols instead of going to the symbol menu, looking through a huge list 
of symbols, and programming those in. In Word 2007 this option remains viable. While the actual 
location of the Autocorrect option is not clear on the ribbons, it is easy to program into the quick access 
toolbar. In the dialog box that comes up, select the drop down menu at the top of  the screen where it 
says “choose commands from” and select “all commands” and then scroll down to where it says 
“Autocorrect Options”. This is the button you want on your quick access toolbar. Once you press that 
button, you can program in any thing you want Word to remember. For example, I type /_ and the 
computer instantly changes it to ∠ which is the angle symbol.  

63. Status Bar at the bottom of the active window is a status bar. There are some nice features of this 
status bar that are not available in the old version of Word. For example, Word now counts the number 
of words in the document, as well as the number of pages. Another good feature is that if you send a 
print job to the printer, while the job is still spooling, you can cancel the printing job by clicking on the 
little red X. To the far right of the status bar is the level of zoom you have the document, in case you 
need to make it larger or smaller. In addition, if there is a typo or grammatical error in your document, 
the little icon to the right of the number of words will contain a red X which you can select in order to 
change those typos or errors. 

 
64. Mid-Document Changes If you want to change something about a 

single line of typing, you can move the cursor to the left side of the 
screen until it turns into the white-filled outline of an arrow. If you 
click the mouse button you will select the entire line of text and a 
ghostly looking menu will pop up looking something like the ghost 
image to the right. This is a very handy little pop-up menu that 
allows you to make important changes to your document. If you 
click on the menu, it will turn opaque, allowing you to see that there 
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are a variety of important changes you can make to your document. You can change the font, the font 
size, make the words bold or italic, center them, highlight them, change the color of the text, work on 
indenting, and make a bulleted list.  

 
 
 
 

Microsoft Word 2003 
 
65. To customize the small-icons 

menu-bar, go to the “insert” 
menu to “Toolbars” and down to 
“Customize” and select the 
“commands” tab. Any command 
you usually use, you can drag 
to your menu bar from there, 
and it will always be available. 
Some of the changes I’ve made to my own menu bar:  

66. To remove items from your small-icons menu-bar, go to the “insert” menu, to “Toolbars” and down 
to “Customize”. Select the “commands” tab. Any menu item that you have never used, nor think you 
will ever use, you can select from the menu bar and drag off the menu into “space”. It will disappear 
from the menu bar permanently, leaving only the buttons you prefer to use.  

67. If you frequently have to choose a specific printer before you print a document, you can eliminate the 
“print” button using tip #2 and replace it with the “print…” button using tip #1. This saves me wasted 
copies.  

68. Alphabetizing a list. If you need to send a list of students out to teachers for a field trip, or any other 
reason, type their names, last name first, one per line and then select the entire list. Use the “Table” 
menu and the “sort” option, and Microsoft Word will sort the entire list for you.  

69. Common Misspellings. Microsoft Word is smart enough to always replace common misspellings with 
the word you really meant to type. But you probably have some words you mistype frequently that 
Microsoft Word doesn’t know. When the word appears with a red zig-zag underline, right-click on the 
word, and go up to the menu item labeled “Auto-correct” and choose the word you meant to type. Now 
Word will correct that misspelling every time you make it.  

70. Shortcuts for symbols and long words. If you use a specific word or symbol frequently, you can 
train Word to insert that word or symbol with only a few keystrokes. For example, if I type the symbols 
“( )” my computer will replace it with “°“. To do this, you go to the “Tools” menu, then down to 
“Autocorrect Options”. In the window that pops up, you select the “Auto Correct” Tab and then go to 
the “Replace” and type in the keystrokes that you want to use. Then in the “With” box you put the 
symbol or word you would like Microsoft to put in place of the shortcut. That way you can save time 
typing or looking up a specific symbol. 

71. Spice Up Documents. One way I spice up my documents is by going to the “Format” menu, down to 
“Borders and shading” and then selecting the “Page Border” tab. In the middle towards the bottom is 
the “Art” option and there are a number of borders already available from Word. These make creating 
a certificate easy. 

72. Send a document. If you want to send a document that you are working on, go to the “file” menu, 
down to the “Send To” option, and over to “Mail Recipient (as attachment)”. This will send your 
document as an attachment that they will be able to open and edit if desired.  

 
Outlook 2003 – Email program and a Whole Lot More 

73. Using the Calendar: Your email program has many features that are very useful in keeping track of 
what is going on in your life, both at school and at home. It is especially useful if you are on a 
committee or hold meetings that people must attend. When in Outlook, look at your screen and notice 
that you have a calendar option on the bottom left hand side of the screen. Select the calendar and 
you will see it before you as a daily schedule, a weekly calendar, or a monthly calendar. Select the day 
and time that you have an appointment and double click. Type in the subject of your meeting. If 
necessary the location, and if you want you can even give it a color. This will put the item into your 
calendar, and as long as Outlook is open, it will send you a reminder of your appointment.  
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74. Reminding others of appointments: If you want to be sure that others are reminded of the 
impending appointment, you can click the button in the middle of the menu bar that says “Invite 
Attendees” and then choose all the people you want to be reminded about this meeting. They will have 
the opportunity to accept, decline, suggest a new meeting time, etc. If they accept the appointment, 
their computer will pop up a reminder screen before the event to remind them of their appointment.  

75. Folders if you want to organize the email you receive, it is useful to create folders 
inside the inbox folder. You can move important emails into those folders and delete 
any unimportant emails. An example of how I’ve used folders:  
 I have a place to put all of my emails to and from parents, room for the department 
chair emails, emails I need to keep because they contain important information I will 
refer to throughout the school year. The math and science club folder for emails 
pertaining to that club. Meet & Confer issues go in that folder. Personal emails, what 
few I get, are put in that folder, and there is a folder for summer school issues and for 
webmaster issues. This helps me to be organized with my emails, and quickly find an 
email I’ve kept.  

76. Filters. To filter out some spam that gets through the established spam filters, go to 
the “Tools” menu then down to the “Rules and Alerts” option. In the window that pops up select the 
“Email Rules” tab and you can create a number of filters. This is also helpful if you want email from 
specific individuals to go to a specific folder, you can create a rule in this window that allows all email 
from your department head to go to one folder, or if it is from an annoying stalker it can go into the 
trash folder.  

77. Email tip #1. With the number of junk emails that are being sent around the internet, it is important that 
certain etiquette be followed, especially with WORK email. NEVER forward a “cute” email to any of the 
BUHS groups.  

78. Email tip #2. When you get an email with some alarming fact included on the email that suggests you 
forward it to everyone you know for their safety or education, check the validity of the information at 
www.snopes.com This website is not itself perfect, but they have most of the email hoaxes listed on 
this site. You will save yourself a lot of embarrassment if you first look it up. Many of the email “alerts” 
you receive are really just urban legends coming to roost.  

79. Email tip #3. NEVER EVER send an email to ANYONE that promises them good luck if they pass it 
on, and eternal damnation if they don’t pass it on. Chain emails like this are one of the scourges of the 
internet. They are RUDE to any recipient you send them to. They are also a way that spam-email 
harvesters find email addresses to add to their lists. Every time you forward a chain email, you are 
sending SPAM to the people you care about, and MORE spam from those who harvest email 
addresses.  

80. Email Tip #4: Avoid cutesy smiley symbols that require an extra program to add them on to your 
emails. The more images, icons, and backgrounds you add to emails, the larger your emails, the more 
work the servers have to do to process all of your emails.  

81. If you receive Spam: If it says [spam]  or you just KNOW it is spam, then send it to the IT department  
Jmurray@buhsd.org so that they can block it permanently.  

82. Spam Tip #1: If you get an email that says “Your friend has sent you an email greeting” or any other 
version of this type of subject, do not open it. These are ways to harvest email addresses and 
propagate viruses. If you think it is a friend, email that friend and give them your home email address 
and ask that they do not send such things to your work address.  

83. Spam Tip #2: If you get an email with an attachment from ANYONE you don’t know, delete it 
immediately. Do not let curiosity result in a virus. This crashes the system, results in the loss of data, 
and gets the IT guys REALLY mad at you.  

84. Spam Tip #3: Never open emails if you don’t know the sender, especially if the subject line appears to 
be a non-sequitur.  

85. Signature: To put a signature on all of your email messages, go to the “Tools” menu, down to 
“options” and then select the “mail format” tab. Click on the “Signatures” button at the bottom right, and 
then click “new…” Name the signature, and choose to start with a blank signature. Click “next” then 
type the signature you want to be on the bottom of all of your emails. Click “finish” and you will see a 
preview of what your signature looks like. Click “ok” and then select the name you gave your signature 
in the pull-down message to the right of “Signature for New Messages” and to the right of “Signature 
for replies and forwards”. Play with this feature, you will discover a lot of fun options.  

 


